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In your Side Panel you'll find:

Getting started

SIDE PANEL

TOOLBOX

This panel contains:

TOP PANEL AND DRAWING INSTRUMENTS

Market Watch
Navigator

Symbols
Ticks

Here you'll find:
Current trades
History of  trades
News
Mailbox
Calendar
Company

Market
Alerts
Signals
Articles
Code base
Experts
Journal

CHARTS PANEL

Here you'll find:
Charts of 
specific trading 
instruments (by 
your own choice), 
Depth of market

One click trading
Trading functions 
(Buy/Sell)

Auto trading
Virtual server
Chart functions

Signal Service
Drawing tools
Timeframes
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Open an account
To open a new MT5 account, please visit your IFX Brokers Client Portal:
https://ifxbrokers.com/login

You can then select Trading Accounts from the menu. You can choose between a new 
Live Account or Demo Account. The details of your new account will then be displayed, 
as well as emailed to you.

Netting or hedging accounts
There are two different types of accounts that you must keep in mind while trading.

THE FIRST ONE

The hedging system allows you to open as many positions as you want in one symbol. 
What makes this account exciting, is the fact that there is no limitation to the number 
of positions you can hold at the same time. Your current positions don't change and 
positions are additionally opened after one another. The example below shows 
executions of two 1.0 lot EURUSD trades simultaneously.

The hedging account is a very common execution method - this account type allows 
multiple open positions on one single symbol. The netting account system will simply 
limit your trading activity in terms of open positions. As you can only have one open 
position for one symbol.
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Where to check your 
account type

As seen in the previous section, the MT5 platform allows you as a user to trade using 
either Hedging or Netting. Next up, after you've created your account, you as a user can 
identify if your account is hedging or netting by simply looking at the ''Journal' ' tab of 
the ''Trade'' window.

See the example below.

Market watch
The Market Watch Window - This window provides you with an overview of the price 
data of financial instruments, namely: prices, statistics, quotes and tick charts.

This window also provides you with more details on the contract specifications and 
One Click Trading options.

The market watch window allows you to list or hide interested financial instruments
and other price data such as high/low, spread, source and times. The displayed data 
can be configured in the context menu. A good example to explain, the user can show 
the ''Source'' field (the provider of the financial instrument liquidity).
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Then, by double-clicking on one of the instruments, allows the user to open a new 
position opening window. How to open a symbol chart - you can open it by dragging
it to the chart viewing area using a mouse (Drag’n’Drop), in this case, windows
of currently open charts will be closed. But you can hold down ''Ctrl'' while dragging, 
then the chart is opened in a separate tab and your other charts remain open.

Adding new symbols - ''click to add'' field, the available financial instruments will appear 
as you type or search. When you right-click on market watch and click on the ''Show 
All'' tab, it will list all the available products at once. You may want to hide them, you can 
do this by simply clicking on the ''Hide All' ' to make them disappear.

Symbols
This is a very handy page - the Symbols page is where you can find information about a 
specific symbol. Follow the steps: Go View > Symbols or click ''Symbols' ' by 
right-clicking on the market watch. Here you can retrieve bars or ticks to see historic 
data or find the contract specifications of a specific symbol.

SPECIFICATION
Here you can browse symbol properties of each financial product. This is where
you'll be able to see basically all the information you need to know while trading, for 
example, you may see maximum/minimum trade size, contract size, trading hours and 
swap long/short rate etc.
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BARS
Here you'll be able to retrieve historic data of bars, you can choose a time range
and select a timeframe (M1, 15M, 1H, etc.). The Historic data includes Open, High,
Low and Close and can be easily exported to Excel .csv file, by simply clicking
''Export Bars'' located at the bottom of the window.

TICKS
Here you'll be able to retrieve BID and ASK of a specific symbol at a specific time 
range and you'll also be able to export this into an Excel .csv file by simply clicking
the ''Export Ticks'' button located at the bottom of the window.
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Placing a trade
This section will discuss the various ways you can place a trade. There are multiple 
ways to place a trade in MT5, you can make use of the option that suits you best.

NEW ORDER
Example number 1 of placing an order - Select the ''New Order'' button or press F9,
by doing this it will bring up the standard MT5 order window.

TICK CHART

First of all, the Red price is Ask and the Blue price is Bid. The tick chart is the 
movement of the last decimal place of the symbol.

SYMBOL

Defaults to the active chart. But keep in mind, that you can choose any available pair 
to place a trade on.

TYPE

This is where you can decide if you want to place a trade at Market (Market 
Execution) or Pending order. If you select a Pending order, further options will appear 
so you can choose whether you want to place whether a Buy Stop, Buy Limit, Sell 
Stop, Sell Limit, Buy Stop Limit and Sell Stop Limit.
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PRICE

This is the level at which you want to place your Pending order.

STOP LOSS

Price level at which you want to exit the trade if in the loss.

TAKE PROFIT

Price level at which you want to exit the trade if in profit.

COMMENT

This is where you can Add a comment to your trade.

BID / ASK PRICES

The active market Bid price and Ask price.

If all the above details has been selected, you can then choose the following: If it's
a Market Execution trade you can press either the “Sell by Market” or “Buy by Market” 
buttons to place the trade.

If it's a Pending order type you can click the ''Place'' button.
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One click trading
Method number 2 for placing a trade - use the One-Click trading method.
This One- Click method allows you to place an order directly in the market without the 
above- mentioned New Order window appearing. How to choose this option: You must 
first go to the Tools menu > Options > Trade tab and select the One-Click trading 
option.

When you click the SELL or BUY buttons above you are placing an at Market Execution 
order at the currently displayed prices and specified volume, i.e. 1.00 lots. Press the up 
or down arrows to increase or decrease the volume you want to place or type in the 
volume directly.

PLEASE NOTE! That when selecting price levels for either entry or exits, those prices 
are never guaranteed to be filled at the exact levels. Slippage may occur and we 
recommend you familiarize yourself with our policies around that subject.

One-Click-Trading also allows you to place a pending order by right-clicking on the 
chart/window at the precise level you want.

If you right-click above the current price level it will present you with the Sell Limit and 
Buy Stop order options. This will place the order directly at the volume you have 
selected in the Trade Panel above. This allows you to change that preset volume within 
Trade Pane.
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HOW TO QUICKLY ADD SYMBOLS
To quickly add a symbol in the Market Watch, click + below the list and enter the 
name of the symbol. While you type in the name, the list of suitable symbols is shown.
Information about the current number of symbols in the Market Watch and the total 
number of available symbols is available at the bottom of the list.

If you work with different brokers or markets, you can save separate Market Watch 
settings for each of them. Create a list of symbols, select the desired columns and 
click "Symbol Sets — Save as". The saved set becomes available for quick switching 
through the same menu.

WHAT IS THE BEST WAY TO SORT SYMBOLS?
Click any column heading to sort the list of symbols. The list can be sorted by symbol 
name, close price, daily change, and other factors, for example. The most popular 
sorting options are available in the context menu. When trading exchange 
instruments, sorting by the largest growth and fall based on a daily symbol price 
change, for example, can be advantageous.
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Depth of market
The last method of placing an order in MT5 is by using the Depth of Market window - 
select this method by clicking the Depth of the Market button in the top left of the
chart/window or you can press Alt-B.

This will bring up the standard MT5 order window.

The Depth of Market window method allows you to zoom in on the tick chart price 
levels and graph whilst giving you the ability to instantly place your orders from within 
the same window.

You can click on the “Sell” or “Buy” button then you'll place your order at Market 
Execution, at the volume specified, i.e. 1.0 lot.
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By clicking on the arrows you are placing a Pending order, relative to the price.
Simply hover the mouse cursor over the arrows to familiarize yourself with the types
of orders.

If you click above the price level you are entering in with either a Sell Limit or But Stop 
order at the volume specified, but if you click in below the price level you are entering 
with either a Sell Stop or But Limit order at the volume specified.
You can also set Stop Loss and Take Profit levels in ticks, next to where you set the 
Volume of order. Once your order has been placed it will be displayed under your Trade 
column.

The Dept of Market is different on the exchange and over-the-counter markets:
If an instrument is traded in the exchange mode, in which related trading operation
 are sent to an external trading system (an exchange), the DOM features real prices
and order volumes from market participants.

If an instrument is traded in the over-the-counter (OTC) market, the Depth of Market
can be formed based on the quotes of the broker, who may provide different prices 
depending on the buy or sell volume.

If the broker does not provide volumes, the DOM window functions as a scalping tool, 
which allows the placing of market and pending orders with a single click. In this case, 
the Depth of Market displays price levels calculated based on the Bid and Ask prices 
using the price change step.

FOR MORE INFORMATION ABOUT PRICES IN THE DEPTH OF MARKET, PLEASE 
SEE THE PRICE DATA SECTION ON METATRADER 5'S WEBSITE AND GUIDE:
https://www.metatrader5.com/en/terminal/help/trading_advanced/price _data

To open the depth of market of a financial instrument, click "Depth of Market Depth"
in the context menu of the Market Watch.

The number of bids and offers displayed in the DOM is determined by the symbol 
parameters set by the broker.

The availability of the Depth of Market feature for exchange instruments is not 
guaranteed and depends on your broker.

TO OPEN THE DEPTH OF MARKET
OF A FINANCIAL INSTRUMENT, CLICK
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Operations of two types are performed from the depth of market:

Market Operations — buying/selling a financial instrument at the current market 
price;

Trade Requests — placing various trade requests (pending orders) to buy/sell a 
financial instrument at a specified price (which is currently unavailable on the market).
To open the depth of market of a financial instrument, click
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Chart
The appearance and properties of each chart in the terminal can be set individually.
To do this, the user must execute the menu command "Chart - Properties". You can also 
invoke this command by pressing F8. The "Properties" window will then appear, where 
you can set the colour of the various elements of the chart ("Colours" tab):

Background - background colour of the 
diagram

Foreground - the colour of axes, scales, 
OHLC line

Grid - the colour of the chart grid Bar Top - 
bar top, shading and border of the Bull Candle 
body

Bar Down - Bar Down, shading and fraying of 
the Bear Candle body Bull Candle - the colour 
of the Bull Candle body

Bear Candle - the colour of the Bear Candle 
body

Line chart - line chart and Doji bars

Volumes - volume and height of open 
positions

Ask price line - the colour of the Ask line

Last price line - the colour of the Ask line

Stop levels - levels of stop orders (stop loss 
and take profit).
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Maximum bar
There is a difference between the bars stored in history and those shown in charts. 
This difference is determined by the fact that any amount of bars can be kept in the 
hard disk provided that it has enough space. But the amount of bars shown in the chart 
is limited by the computer resources.

Bars displayed on the chart are used for drawing technical and custom indicators. 
When multiple indicators and a large amount of data to be displayed are used 
simultaneously, computer free resources (CPU load and free RAM) can exhaust very 
soon.

To avoid such problems, you can set the amount of data displayed on the charts.
This can be done by selecting a corresponding value from the pop-up list or by entering 
a value manually in this field (minimum value is 5000). For the changes of this parameter 
to take effect, restart the platform.

Charts show up to 100,000 bars by default. However, on some occasions you can only 
see few or limited number of bars in a chart. Then you can modify chart settings from 
“Tools – Options – Charts”. The number of bars in one chart can be set from 5000
to unlimited. If your trading device’s CPU load and RAM is available and can process
the larger numbers of bars smoothly, you may increase the number of bars accordingly. 
Vice versa, if your device cannot afford high load of bars, consider lowering number
of bars in a chart.

Timeframes
To set timeframes of a chart, you can look for “Timeframes”.

Please go to “View > Toolbars > tick Timeframes”.
This will bring up below timeframe scales. Now you can target a chart and choose
how much each bar/candle/line represents in time.

Additionally, users can choose from more timeframe options on MT5. Simply right click 
on the chart and look for “Timeframes” arrow
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Drawing
MT5 bolsters drawing instruments to assist clients do chart analysis. They can draw 
utilizing underneath pre- installed drawing tools. You can get to this by clicking “View – 
Toolbars – Line Studies”. Basic drawing instruments show up within the tool kit includes 
line drawing, texting box. Additionally, you'll be able get to more drawing devices by right 
clicking on drawing devices and tap “Customize”. You can add or expel from “Available 
buttons” and “Selected buttons”

Chart view functions
DOCKING CHART

The trading platform allows you to detach charts of financial symbols from the main 
workspace of the terminal. This feature is convenient when you use multiple monitors.
Thus, you can put the main window of the platform on one monitor to check your 
account balance and move your charts to the second screen to monitor the market 
situation.

To detach a chart from the terminal, uncheck the "Docked" option in its context menu. 
Then move the chart to the desired monitor.
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WINDOW/CHART VIEWS
If you are working with multiple charts on one screen, you can also click the following 
button (or press Alt-R) to make all the charts fit on the same screen.

Simply click the Maximize button on the selected chart to maximize that chart again.

You can also zoom in and out of the charts by using the toolbar buttons or the + 
(zoom in) and - (zoom out) keys. If you choose the Window menu, you can arrange
the windows the way you want.

Cascade - Place all windows/diagrams on top of each other.

Tile Horizontally - Adjusts all windows/charts horizontally across the screen.

Tile Vertically - Adjusts all windows/charts vertically across the screen.
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Metaquotes language 
editor

With the MetaQuotes Language Editor you as a trader can create individual indicators, 
Expert Advisors and scripts. These can be created either with the built-in MQL Wizard 
or by programming them in the MQL5 programming language, which is included in 
MetaTrader 5.

Indicators - Allow you to display objects on charts that can help you give signals 
when certain price or other indicator criteria are met.

Expert Advisors (EA) - Are programs that can be run continuously to automatically 
generate signals or trades. Also known as robots or algorithms.

Scripts - Are like programs that can generate signals or trades. However, they
are executed only once and cannot run continuously.

To access the MetaQuotes Language Editor in your MT5 platform, either locate
it in the toolbar or press F4 on the keyboard. Or go to the Tools menu > MetaQuotes 
Language Editor.

For more information about the MetaQuotes Language Editor and MQL5, press F1
to access the User Guide or you can visit https://.www.mql5.com/en/code
for more detail.
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Register a virtual server
The Virtual Server service allows you to run your Expert Advisor trading strategies
to execute on one of the MQL5 Virtual Servers around the world. Unlike running on your 
own local computer, a Virtual Server runs extremely close to the iFX BROKERS server. 
This means that trades can be executed much faster than normal.

Signal service
The Signals Service allows you to subscribe to signals/trades that are copied to your 
MT5 account by another trader in the MQL5 community. You can also set up the signals 
service through a virtual server.

To use the MQL5 signal service, you can find it in your toolbar, where you can also sign 
up for a free MQL5 account.
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Strategy tester
The Strategy Tester allows you to backtest the performance of Expert Advisors/robots 
and their strategies on the previous history within the MT5 platform. This tool can help 
you to test the efficiency of a programmed strategy on past price quotes as well as 
establish the best input variables before running the robot on an account in real-time.
There are examples Expert Advisors provided to you in the Platform for you to test, 
however, the functionality of the Strategy Tester is beyond the scope of this 
documents.

To access the Strategy Tester, you can find it in the toolbar or press CTRL-R.
Alternatively, you can find it under the View menu.

For more information on the Strategy Tester please visit 
https://www.metatrader5.com/en/automated-trading/strategy-tester

Toolbox
This section describes the functions within the Toolbox window.
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TRADE
The Trade tab displays a list of your currently open trades.

You can click on the column headers to sort the trades by that column in ascending 
or descending order. If you right-click anywhere on the trading window, you will be 
presented with additional options, including:

New Order - Place a new order. When an active position is selected, you can also 
choose to Close / Modify or Delete the order.

Volume - Select whether you want to view the trade sizes in lots or the total amount.

Profit - Select whether you want to display the profit column either in your account 
currency or in points/pips.

Report - Export the trade history to a local file.

View on charts - View other selected symbol trades.

Register as Signal - Submit your trade to the MQL5 community.

Show milliseconds - show/hide milliseconds of the opening/closing time of trades.

Grid - shows/hides borders around trades.

Columns (commission/swap) - show/hide Commission/swap and comment 
columns of trades.

HISTORY
The History tab allows you to view all the details of your completed trades. You can 
view and filter trades by date range, as well as click on the column headers to sort 
trades by that particular column in ascending or descending order.

If you right-click anywhere in the history window, you will be presented with 
additional options for viewing, including:

Positions/Trades/Orders - Displays your trades in different ways.

Symbols - Select the symbols you want to display.

Volumes - Choose whether you want to view trade sizes in lots or total amount.

All history/last 3 months/last month/customer period select the date range
of the trades.

Report - export the trade history to a local file.

Show milliseconds - show/hide milliseconds of opening/closing time of trades. 
closing time of the trades.
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This will display the corresponding trading history in the Toolbox window. Right-click 
again in the Toolbox window and select under Report whether you want to save your 
report as an XML file or as an HTML file. This will create the appropriate file that you 
can save to your computer and open from there

Grid - shows/hides the frame around the trades.

Columns (Commission/Swap) - shows/hides the commission and swap
of trades.

YOU CAN MAKE A REPORT ON YOUR 
TRADE HISTORY

This is how:
Many traders need trade statements for personal analysis or tax purposes. MT5 
provides you with the ability to generate reports on your entire trading history
or on user-defined time periods.

To start this process, you need to display the Toolbox window(Note: In MT4,
this window used to be called the Terminal window). Call the Toolbox window from
the toolbar or press CTRL -T.

Alternatively, you can call it up from the View menu. This will display the Toolbox 
window. Click on the History tab, which displays the current month's trade history. 
Right-click anywhere in the window and select one of the 4 options:

All history

Last 3 months

Last month

Custom period (here you can select a specific to and from date).
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NEWS
On the News tab, you can find a list of current financial news from all over the world.

MAILBOX
The Mailbox tab displays messages sent either by MQL5 or your broker.

CALENDAR
On the Calendar tab you can find important events and financial data releases 
(including previous, forecast and current figures) that can have an impact on the prices. 
There are several options associated with the Calendar tab that you can view and 
change by right-clicking on them.

Export - Allows you to export the currently displayed events to a local HTML file.

Previous Week / Current Week / Next Week - Displays the events for
the corresponding period.

Previous Month / Current Month / Next Month - Displays the events for
the corresponding period.

Priority - Shows/hides all events and holidays, events with low priority, medium 
priority or high priority.

Currency - Shows/hides events by currency.

Country - shows/hides events by country.
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MARKET
The Market tab shows a list of free and paid experts, Indicators, Libraries and Utilities 
that you can use on your MT5 platform. Simply select the product you want to 
download and either purchase it first or, if it is free, click the Download button so it can 
be downloaded and used directly on your MT5 platform.

Once the product installation is complete, you can access it from the Navigator list.
Go to the View menu > Navigator or press CTRL -N.

Search for your product under the appropriate category. Once you find the product, 
double-click on it or drag it to your active chart to apply it.

Please note that indicators and Expert Advisors usually have settings that you can 
change. Select the desired setting and your product will be applied to the active chart.
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ALERTS
The Alerts tab displays a list of all the alerts you have created for your charts. Alerts are 
used to display a message and an alarm when the price reaches the level you set. 

Right-click on the alert to either modify, delete, or enable/disable it. Click Create to create 
a new alarm. Please note that alarms on MT5 are stored locally on your computer, so if you 
want to receive them, you need to turn on your computer and run MT5.

To create a new alert on your chart, right-click on the chart at the price level you want 
to set the alert for. Then select Trade > Alert. This will trigger an alert at the price level 
you set, indicated by the red arrow on your chart.

You can change the price level of the alert by clicking and dragging it to the desired 
location. Or by clicking the right mouse button on the Arrow and selecting Modify, Delete 
or Disable. If you choose Modify, you can change various settings in the Alarm Editor,
as described below.

Enable checkbox - enable/disable the alarm.

Action - select how the alarm should be issued - via a sound, print to a file, send to an 
e-mail (mail) or a cell phone

PLEASE NOTE: you must set up your email or cell phone (at Tools > options) to accept this 
form of notification.
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Icon - Select the icon where you would like to be notified.

Source - If the Sound action is selected, you can select the sound that will be heard 
when the alert is triggered. If the File action is selected, you can select the output file to 
which the alert will be printed. If Mail is selected, you can change the email that will be sent.
For the Notification action, there is no change.

Timeout - You can select the timeout between alarms. Similar to the snooze function
of your alarm clock, here you can set whether the alarm should remind you again after
it has been triggered for the first time.

Maximum Retries - The number of times the alarm should retry from the time it was first 
triggered.

Expiration - You can set an expiration date and time for your alarm.

Condition - define what condition should apply in relation to the rate value you set (see 
below).

BID > BID PRICE IS GREATER THAN PRICE VALUE SET

BID < BID PRICE IS LESS THAN PRICE VALUE SET

ASK > ASK PRICE IS GREATER THAN PRICE VALUE SET

ASK < ASK PRICE IS LESS THAN PRICE VALUE SET

LAST < LAST PRICE IS LESS THAN PRICE VALUE SET

LAST > LAST PRICE IS GREATER THAN PRICE VALUE SET

VOLUME < VOLUME IS LESS THAN VALUE SET

VOLUME > VOLUME IS GREATER THAN VALUE SET

TIME = SERVER TIME IS EQUAL TO TIME VALUE SET
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SIGNALS
"Signals" is a convenient service for automatic copying of trading operations of 
professional traders directly to your account. All accounts registered with this service are 
provided with detailed statistics and a complete trading history. Besides, any user can 
become
a provider and sell his own trading signals.

Working with the signals service has a lot of advantages:

There is no need to conclude a contract between a provider and an investor.

Copying of trades is fully automated. Your participation is not required.

A signal provider and a subscriber can have accounts with different brokerage 
companies.

Ultra-fast data exchange protocols significantly reduce delays in executing orders
on a subscriber's account.

Data transfer is absolutely secure.

Fixed subscription price, no additional commissions for a subscription.

To use the Signals service, you need a valid MQL5.

Community account, specify it in the platform settings. If you do not have an account yet, 
please register. Please note that you can subscribe to demo accounts as well as real 
accounts for signal services. To subscribe to a signal service, select the signal service 
provider you are interested in. Then click the Free subscription button. Once you have 
selected your subscription options and agreed to the terms and conditions, your trading 
account will now accept automatic trading signals from that provider.
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Articles
On the Articles tab, you will find a list of all articles published on the MQL5 website. 
These include articles on all trading topics such as strategies, systems, Expert Advisors 
and statistics. Just double-click on any of the articles to read it in your web browser.

Code base
The Code Base tab shows a list of Expert Advisors, Indicators and Scripts that you can 
download for free.

There are several options when you right-click on a product.

View - Brings up the website and shows you more details about the product, including 
how it works, performance tests, and details about the settings.

Download - This allows you to download the product directly to your MT5 platform. 
After downloading, simply access your Navigator window (CTRL - N or View menu > 
Navigator) and locate the product you downloaded in your list. You can then either 
double click on the product or drag it onto your chart to use it.

Order your own program - takes you to the MQL5 Freelance service where you 
can have your own ideas programmed into an Expert Advisor, Indicator or Script.

Expert Advisors / Indicators / Scripts - filter which categories you see in the list.

Experts
The Experts tab displays a journal for your Expert Advisors. Every action performed
by your Expert Advisors, including errors, is logged here. Advisors are logged here and 
can be used to troubleshoot your strategies.
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Journal
The Journal tab displays a journal for each action performed on your MT5 platform.
If you have problems with MT5, you can view the log on the Journal tab and fix
the problem.

Help topics
In addition to this guide, customers can find help in the built-in MT5 platform user guide. 
You can find it at "Help > Help Topics" or press F1.

Alternatively, you can also download the online manual of MetaTrader5 here at 
https://www.metatrader5.com/en/Terminal/Help

Password change
To change the account password, click "Edit". After that the following window opens:

The following details are to be indicated in the password changing dialog:

After specifying all the data click "OK".
A password cannot be changed if the current password is not specified.

Login - account number, this field cannot
be changed;

Current password - the field to enter
the master password;

Change master password - select 
this option if you want to change the 
master password of your account;

Change investor password - select this 
option if you want to change the investor 
password of your account;

New password - field for entering a new 
password;

Confirm - field for confirming a new 
password.
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New language selection
To select language of incoming news, click "Edit" next to the appropriate field.

Mobile trading
The trading platform provides opportunities for financial trading and market analysis 
with the most popular mobile devices based on iOS and Android. On mobile platforms, 
you can manage your trading account, view price charts, use technical indicators and 
analytical objects. Furthermore, you can read financial news, be notified of important 
events in the account, and send messages through your MQL5.community account.

Mobile platform for iphone/ipad
Features of the Mobile Platform for iPhone/iPad:

Realtime charts of financial instruments

A complete set of market and pending orders

Trading on chart & Financial news and 
internal mail

Access to the account's history of trades

Technical analysis using 30 major technical 
indicators and 23 analytical objects

Customizable charts and 9 timeframes: M1, M5, 
M15, M30, H1, H4, D1, W1 and MN1

Instant messaging with MQL5.community 
members
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Getting Started on 
a mobile device

To start trading from your mobile device, download MetaTrader 5 on iTunes or from
the AppStore application on your iPod Touch/iPhone/iPad.

After installation, run the application by tapping MetaTrader 5 on your device. This will 
open the following screen. The application version number is shown at the bottom
of the screen.

OPENING A DEMO ACCOUNT AND 
CONNECTING TO AN ACCOUNT

When you initially launch the application, a demo account will be created for you so that 
you may begin researching trading opportunities and testing your techniques right away.
If your broker does not allow you to open demo accounts automatically, you will be given 
the following options:

If you want to create a new demo account, click Open a Demo Account. Requesting a 
new real account from a particular broker is possible when you open a real account. You 
must supply personal information as well as identity papers.

Connecting with an existing account requires logging in to an existing account.
In a separate area, you'll find extensive instructions on how to work with accounts.
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APPLICATION GUI
The MetaTrader 5 mobile platform's entire interface is made up of the main working 
area and the bottom panel, which are used to transition between the program's 
primary functions:

Quotes provide real-time information on the prices of financial products.
A price chart is available, as well as technical analysis alternatives such as indicators 
and graphical objects.

Trade shows the current state of your account and provides choices for managing 
trade positions and pending orders.

The account's history includes the account's trading operations.

Settings give you access to the app's settings, MQL5.community chat, mailbox, and 
news, as well as the ability to create new accounts or swap between existing ones.

Quotes
The Quotes tab allows users to view real-time pricing information on financial 
instruments. To switch to this tab, use the bottom panel of the MetaTrader 5 for iPhone.
The following price information is shown here:

Financial instrument name

Above the name: a change in the current 
price relative to the previous trading 
session close, in points and percent

Under the name: last quote arrival time 
and spread

Bid price

Ask price

The lowest price for the current day (Low)

The highest price for the current day (High)
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HIDING SYMBOLS
To hide a symbol, go to the edit mode by tapping Modify        at the top
of the "Quotes" screen.

To hide a symbol, select it Hide       . Then tap on Delete

MOVING SYMBOLS
To change the symbol's display order, enter the symbols list edit mode by tapping 
Modify at the top of the "Quotes" screen.

Then tap Move on the desired symbol and holding it, drag the symbol to the desired 
position.

ADDING SYMBOLS
To add a new symbol, tap on the search box at the top of the Quotes screen and 
start typing the symbol name.

Select a group of symbols. To quickly find the desired symbol, use the search bar
at the top of the screen. When you start typing the symbol name, appropriate 
filtration is applied. To add a symbol, tap Add a symbol against it. When you are 
finished, tap "Done".
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QUICK COMMANDS
Swipe left on the symbol line to open the quick commands menu:

SYMBOL PROPERTIES
Symbol trading terms are shown in this tab. You can switch to this screen using
the "Properties" command in the context menu of the "Quotes" tab.

The following parameters set by a broker are shown here:

By dragging the menu further to the left, you can immediately switch to the symbol 
chart.

Perform a trading operation for the 
selected symbol

Open the chart of the selected
symbol

Symbol name and description – 
name of a symbol and its short description;

Spread – spread in points. If the 
spread is floating, then the appropriate 
record is specified in this point (floating)

Digits – number of decimal places
in the price of the symbol.

Stops level – channel of prices (in points) from 
the current price, inside which placing of Stop 
Loss, Take Profit and pending orders are not 
allowed. When placing an order inside the 
channel, the server will return the "Invalid Stops" 
message and will not accept the order.

Contract size – number of units of the 
commodity, currency or financial asset in one lot.
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Margin currency – currency, in which the margin requirements are calculated

Profit currency – currency, in which the profit of the symbol trading is calculated

Calculation – method of profit and margin calculation: Forex, Futures, Exchange 
Futures, Exchange Stocks, FORTS Futures

Initial margin – security deposit (margin) provided for a fixed-term contract
to perform a one-lot deal. If the initial margin value is specified for the symbol, this
is the value that is used. Margin calculation equations are not applied to the appropriate 
calculation type

Maintenance margin – minimum security deposit (margin) a trader should have
on his or her account to maintain a one-lot position

Hedged margin – the margin charged per one lot of hedged positions Margin 
calculation mode using the larger leg for hedged positions can also be specified here

Margin rate – margin rates for various order types are specified in this table.
The rates are set for the initial and maintenance margin individually If no ratio is set
for the maintenance margin (set to zero), the initial margin ratio will be used for it

Market Buy Order – a multiplier for calculating margin requirements for long positions 
relative to the basic margin amount

Market Sell Order – multiplier for calculating margin requirements for short positions 
relative to the main amount of margin

Buy limit – multiplier for calculating margin requirements for Buy Limit orders relative
to the main amount of margin

Sell limit – multiplier for calculating margin requirements for Sell Limit orders relative
to the main amount of margin

Buy stop – multiplier for calculating margin requirements for Buy Stop orders relative 
to the main amount of margin

Sell stop – multiplier for calculating margin requirements for Sell Stop orders relative
to the basic margin amount

Buy stop limit – multiplier for calculating margin requirements for Buy Stop Limit 
orders relative to the main amount of margin

Sell stop limit – multiplier for calculating margin requirements for Sell Stop Limit 
orders relative to the main amount of margin

Trade – symbol trading mode (full access, long-only, short only, close only) Also, trading 
can be completely prohibited

Good till today including SL/TP – orders that are valid only during one trading day. 
At the end of the day, all Stop Loss and Take Profit levels are deleted, as well as 
pending orders are removed
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Good till cancelled – pending orders are preserved as trade day changes Good till 
today excluding

SL/TP – only pending orders are deleted at the end of a trading day, while Stop Loss 
and Take Profit levels are preserved 

Minimal volume – minimal deal volume for the symbol

Maximal volume – maximal deal volume for the symbol

Volume step – step of volume changes

Volume limit – the maximum allowable total volume of an open position and pending 
orders at the same symbol and in the same direction (buy or sell). For example, the limit 
is 5 lots. I have a buy position of 5 lots, you can place a Sell Limit order of 5 lots. But you 
cannot place a pending Buy Limit order (since the total volume in one direction will 
exceed the limit) or place a Sell Limit order above 5 lots

Swap type – a type of swap calculation

In points – the specified number of points of the security price

In the base currency – the specified amount in the base currency of the symbol

In the margin currency – the specified amount in the symbol margin currency

In the deposit currency – the specified amount in the deposit currency

As a percentage of current price – the specified percentage of the symbol price 
at the time of calculation of the swap

As a percentage of the open price – the specified percentage of the position 
open price

In points, re-open at Close price – at the end of the trading day, the position
is closed. The next day the position is re-opened at the close price +/- the specified 
number of points.

In points, re-open at the Bid price – at the end of the trading day, the position
is closed. The next day the position is re-opened at the Bid price +/- the specified 
number of points

Swap long – swap for Buy positions

Swap short – swap for Sell positions

3-days swap – day of the week when a triple swap is charged

First trade – the day when the financial instrument trading started

Last trade – the day when the financial instrument trading ended
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Face value – nominal bond value set by the issuer

Accrued interest – part of the coupon interest of bonds, which is calculated in 
proportion to the number of days since the coupon bond issue date or since the 
previous coupon payment

Type of orders – types of orders placed

Category – the property is used for additional marking of financial instruments.
For example, this can be the market sector to which the symbol belongs: Agriculture,
Oil & Gas and others

Exchange – the name of the exchange in which the security is traded

CFI – instrument classification in accordance with the ISO 10962 standard

Sector – economic sector the instrument belongs to, such as energy, finance, 
healthcare and others

Industry – industry branch the instrument belongs to, such as sportswear, 
accessories, car manufacturing, restaurant business and others

Country – country of the company whose shares are traded on the stock exchange

Option type – call or put

Underlying – the underlying symbol of the option

Strike price – option strike price
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Depth of market
The Depth of Market (DOM) displays bids and asks for a particular instrument at the 
best prices (closest to the market) at the moment. The DOM window also shows
the volume of each order.

THE DEPT OF MARKET IS DIFFERENT ON 
THE EXCHANGE AND 

OVER-THE-COUNTER MARKETS
If an instrument is traded in the exchange mode, in which related trading operations 
are sent to an external trading system (an exchange), the DOM features real prices 
and order volumes from market participants.

If an instrument is traded in the over-the-counter (OTC) market, the Depth of Market 
can be formed based on the quotes of the broker, who may provide different prices
depending on the buy or sell volume. If the broker does not provide volumes, the DOM 
window functions as a scalping tool, which allows placing of market and pending 
orders with a single click. In this case, the Depth of Market displays price levels 
calculated based on the Bid and Ask prices using the price change step.

TRADE
Trading activities performed from the Depth of Market are directly connected with 
the peculiarities of the exchange execution of operations in MetaTrader 5 for iPhone. 
There are two types of trade operations:

Market Operations – buying/selling a 
financial instrument at the current 
market price;

Trade Requests – placing various requests 
(pending orders) to buy/sell a financial 
instrument at a specified price.
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MARKET OPERATIONS
A market operation is buying/selling a financial instrument at the best price currently 
offered on the market. Market operations can be performed via the Depth of Market 
using Buy and Sell buttons below.

From the Market Depth – execute the appropriate trading command in the Market 
Depth of the required symbol while specifying the required volume. This request to 
execute a trade operation will be immediately sent to the server without specifying
any extra conditions.

The volume must be specified before performing an operation.

SENDING THE REQUEST
Specify the volume of 50 lots and press Buy.
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EXECUTING THE REQUEST
The above screenshot shows that only 10.50 lots at 0.92764 were available atthe 
moment of execution. "Fill or Kill" execution mode is used by default when sending market 
requests from the Depth of Market. It means that the request should be performed
in the specified volume. If the specified volume is not available in the market, the request 
will not be executed.

The necessary volume is available in the market but at a higher price. The requested 
volume will be reached using the best price offers. You can view the history of order 
execution in the "History" tab.

The above screenshot shows that the order was executed in three deals: 10.5 lots
at 1.0.92764, 30 lots at 0.92765 and 9.5 lots at 0.92766.

CLOSING POSITIONS
The Depth of Market allows you to view the state of open positions for a symbol,
as well as to close them quickly if necessary.

To view detailed information about positions for the current instrument, tap on the 
symbol name at the top of the Depth of Market.

To close a position on a netting account, tap "Close" at bottom of the Depth of 
Market. No additional confirmation is needed.

If an account uses the hedging mode, a user can have multiple open positions of the 
same instrument. Therefore, to close a position from the Depth of Market, it must be 
explicitly selected. Only after that the "Close" button will become active.
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PLACING AN ORDER
To place a pending order, tap on the bid/ask volume cell having a required price:

After you tap on the appropriate field, a request for placing a pending order will be 
immediately sent to the server. The order will be displayed in the Depth of Market 
upon successful placement. As soon as there is a market participant ready to sell
the financial instrument at the specified price, the order will be filled and will turn into
a position.

TRANSFERRING ORDERS TO AN 
EXTERNAL TRADING SYSTEM

Pending orders may or may not be transferred to an external trading system 
depending on broker's symbol settings. For example, a broker may transfer Limit 
orders directly to an external trading system while other order types (Stop and Stop 
Limit ones) will be processed in MetaTrader 5:

An appropriate market operation is executed when the stop price specified in a Buy 
Stop or Sell Stop order is reached. When the stop price specified in a Buy Stop Limit 
or Sell Stop Limit order is reached, an appropriate limit request is executed, which will 
be visible to other market participants.

BUY STOP AT 0.92765

BUY LIMIT AT 0.92750

SELL LIMIT AT 0.92764

SELL STOP AT 0.92749
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PENDING ORDERS
Buttons for placing pending orders are located at the right side of Trading column. 
The order is placed at the price with a pressed button.

TRADING SETTINGS
The upper part of DOM shows trade operation settings:

sl – Stop Loss level is set for placed limit orders. This parameter is specified in points 
from the current price.

vol – the volume of created market and limit orders in lots.

tp – Take Profit level is set for placed limit orders. This parameter is specified in points 
from the current price.

MARKET ORDERS
Market order commands are located below:

Sell – perform a Sell deal in the size specified in "vol" field at the best available price.

Close – this button is only enabled if there is an open position for a selected financial 
instrument. It allows you to close the entire position at the best available price.

Buy – perform a Buy deal in the size specified in "vol" field at the best available price.

if this button is pressed in the Bid prices 
area, a Buy Limit order at a specified 
price will be placed; in case it is pressed 
in the Ask prices area, a Buy Stop order 
will be placed;

if this button is pressed in the Ask prices 
area, a Sell Limit order at a specified price 
will be placed; in case it is pressed in the 
Bid prices area, a Sell Stop order will be 
placed.
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Charts
A chart shows price changes over time. You can apply different built-in indicators
to a chart and thus analyze the market. To switch to this tab, use the bottom panel
of MetaTrader 5.

CHART OPENING
To open a chart of a financial instrument, run the "Chart" menu command in
the "Quotes" tab.

There is a limit to the depth of price data that can be displayed in the MetaTrader 5
for iPhone. Depending on your device, you can view 2000 bars and more. As soon as 
the limit is reached, the "Maximum bars limit" notice appears at the bottom of the chart.

For more detail on the chart section please visit the MetaTrader 4 website or use the 
following link https://www.metatrader5.com/en/m 
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How to trade
The simple basis rule for profiting in financial markets is 'buy cheap and sell dear'.
One of the main functions of the MetaTrader 5 mobile platform for iPhone is providing 
a user with wide opportunities to perform buy and sell operations.

The Trade tab features the current state of a trade account, as well as current 
positions and pending orders. To switch to this tab, use the bottom panel of the 
application.

To perform a trading operation, tap New Order

For quick depositing or withdrawing, tap Deposit/Withdraw

ACCOUNT STATE
The current state of a trade account is shown at the top of the tab:

Profit, currency – the total result of the current trade positions and the account 
deposit currency.

Balance – money on the account, not taking into account the results of currently open 
positions (deposit).

Credit – amount of funds provided to a trader by a broker as a loan.

Assets – the current value of purchased financial instruments (of long positions) 
defined in trader's deposit currency. The value is determined dynamically based on
the price of the latest symbol deal taking into account the liquidity margin rate. In fact, 
the amount of assets is equivalent to the amount of money that the trader would 
receive in case of immediate closure of long positions. This rate is used on exchange 
markets.

Liabilities – obligations on current short positions calculated as the value of these 
positions at the current market price. In fact, the amount of liabilities is equivalent
to the amount of money that the trader would pay in case of immediate closure of 
short positions.

Commission – commission by orders and positions accumulated during a day/month. 
Depending on conditions of collection of commission (determined by broker),
a preliminary calculation of commission is performed during a day or a month.

The corresponding amount of assets is blocked on the account and its value is shown 
in this field. Final commission calculation is performed at the end of a day/month and 
the appropriate sum is withdrawn from the account by the balance operation (which
is displayed as a separate deal in the History tab), and the frozen amount is unblocked.
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In case the commission is charged immediately during the execution of a deal,
its value is shown in the Commission field of deals in the History tab.

Blocked – under certain trading conditions (determined by a broker), a profit fixed 
during a day cannot be used to perform trade operations (not included in the free 
margin). This blocked profit is displayed in the "Blocked" field. At the end of the trading 
day, this profit is unblocked and deposited into the account balance.

Equity – equity is calculated as Balance + Credit - Commission +/- Floating 
profit/loss - Blocked.

Margin – money required to cover open positions and pending orders.

Free Margin – the free amount of money that can be used to open positions.
It is calculated as Equity - Margin. Depending on the trading conditions (defined by
a broker), the equity value may or may not consider: floating profit, floating loss or 
floating profit and floating loss together.

Margin Level – percentage of the account equity to the margin volume (Equity / 
Margin * 100).

Total of deals – total financial result of all open positions.
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TRADING COMMANDS
To quickly modify or close a position or order, swipe on its row from right to left. This 
will open a menu of commands:

By dragging the menu further to the left, you can immediately switch to order closing or 
canceling screen.

The same commands are available in the context menu of positions and orders.
To open the context menu, tap on the trading operation line in the list.

For more detail about how to place a trade and more information on how to use MT4 on 
iOS please visit https://www.metatrader5.com/en/ 
mobile-trading/iphone/help

open a context menu with additional commands.

modify position/modify order.

close position/delete order
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RADIAL MENU
The radial menu is opened by a tap on the chart. Using the menu you can:

CROSSHAIR
"Crosshair" mode allows viewing an exact date, price and indicator values at any point 
of a chart. To turn on the mode, tap on Crosshair in the top panel of the chart or in the 
radial menu.

Move the crosshair over any point of the chart, the date and price of the point will be 
appear on the appropriate chart scales.

Each chart is provided with a separate radial menu, which allows accessing the 
settings of the chart.

Change the timeframe

Attach indicators to a chart

Apply objects to a chart

Enable crosshairs

Open chart settings
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RULER
In the Crosshair mode, you can measure the distance from one point on a chart
to another. To do this, set the crosshairs by one finger at the first point, hold it and 
swipe the screen with another finger to the second point.

The crosshair caption contains two values: the distance along the horizontal axis
in bars and the distance along the vertical axis in price terms or indicator values.

DATA WINDOW
Data Window allows viewing spread values (highest spread for the selected bar)
and the indicator values.

To enable the Data Window, open the radial menu and navigate to chart settings.
Then turn on the Crosshair mode and position it at the desired point.
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RESIZING A SUBWINDOW AND SHIFTING 
FROM THE CHART EDGE

If you want to resize an indicator subwindow, long tap (about 1 second) anywhere
on the chart. Specify the desired subwindow size by dragging its upper border.

In the same mode, you can change the shift of the price chart from the right edge
of the window by dragging the dotted line.

To expand the chart to full screen, tap Maximize. To switch between chart windows
in this mode, use the menu Tile windows. To return to the multi- window display,
use the same menu or press Minimize in the chart switch mode.

In order to close a chart tap Close chart next to it.

Tap anywhere on the chart to exit the edit mode.



METATRADER 5 USER GUIDE 53

CHART SETTINGS
To go to the chart settings, open the radial menu and tap Chart settings.

Chart view – select representation of charts:

Bar chart – show the chart as a sequence of bars.

Candlestick – show the chart as a sequence of Japanese candlesticks.

Line chart – show the chart as a broken line that connects close prices of bars.

OHLC – when this option is enabled, current Open, High, Low and Close prices are 
displayed at the top of the chart. Therefore, the exact value of the last bar can always 
be seen.

Show data window – when this option is enabled in the "Crosshair" mode, the data 
window will additionally be displayed on a chart. The Data Window displays the values 
of all active indicators in a specified point of a chart.

Show volumes – volume display options: Don't show volumes and Show tick volumes

Show trade levels – when this option is enabled, all current positions and pending 
orders of a symbol are shown on the symbol chart. Trade operations are displayed as 
lines with signatures at the level of the price, at which they were executed.

Independent charts – if this option is enabled, analytical objects are only created
on the current symbol chart and on selected timeframes. When you switch to other 
symbols/timeframes, the objects will be hidden.
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Show period separators – date and time of each bar are displayed on the horizontal 
axis of the chart. And this horizontal scale interval is the selected timeframe. The "Show 
period separators" option draws additional vertical lines corresponding to the larger 
period (timeframe) borders. Daily separators are drawn for M1 to H1 charts, weekly 
separators are shown for H4, monthly appear for D1 and year separators are used for 
W1 and MN1 charts.

Ask Price Line – show/hide the Ask price level of the latest quote. Bars in the platform 
are formed based on Bid prices (or Last prices if the depth of market is available for the 
instrument). However, at opening of long positions and closing of the short ones, the Ask 
price is always used. The Ask price is not displayed on the chart, so it cannot be seen.
To have a more precise control over trading, enable the "Ask price line" parameter.
An additional horizontal line corresponding to the Ask price of the latest quote appears 
on the chart.

Last price line – show/hide the level of the price at which the latest trade was 
executed. This line can only be displayed if the appropriate symbol price is provided by 
the server.

Colors – select the color display of the chart and its various elements:

Scheme – select a pre-defined color scheme of the chart. Two color schemes options 
are available: "Green on Black" and "Black on White".

Foreground – color of the axes, scale and OHLC line

Grid – grid color

Volumes – the color of volumes and position opening levels

Bar up – color of an up bar, its shadow and border of a bullish candlestick's body

Bar down – color of down bar, its shadow and border of bearish candlestick's body

Bull candle – color of bullish candlestick's body

Bear candle – color of bearish candlestick's body

Line chart – color of the chart line and Doji candlesticks

Bid price line – color of the Bid price line

Ask price line – color of the Ask price line

Last price line – the color of the price line of the latest executed trade

Stop levels – the color of the levels of stop orders (Stop Loss and Take Profit)




